
HOW TO USE ACCORDANCE 10.2.4 

 

 

Accordance software allows you to search for words, phrases, and grammatical constructions in the Greek and 

Hebrew biblical texts, to search the English text, to view numerical and graphical analyses of the results, and to look 

up entries in selected standard reference tools. To begin Accordance, click the icon on the desktop. To end, use close 

and quit as on any Mac. Go to www.accordancebible.com, click Support, and choose Help for more documentation. 

 

The Search Window 

 
Accordance begins with the search tab (see fig. 1). To open another search tab, click the + sign beside an existing 

tab. 

 

 

 
fig. 1 

 

 

Use the search text pop-up menu to select the text you wish to search. Go to About the Text under the Accordance 

menu for information about that text. 

 

In the search window, the drop-down menu (with choice of Words or Verses) is at the beginning of the argument 

entry box. Choose Verses to specify a biblical text, e.g., John 1. Choose Words to specify lexical or grammatical 

targets, e.g., passages using a future passive or passages using a particular word. 
 

You may change the size of the argument entry box by holding the cursor over the bottom line of the box until the 

cursor becomes a double-pointed arrow and then dragging the line to a new position with the mouse. 

 

Displaying a Specific Passage 

 

To display a specific passage, choose Verses in the argument entry box and enter verse references in the argument 

entry box by typing in as much of the name of the book as is necessary to identify it uniquely. Commas, hyphens, 

colons, and semicolons have the same meaning in Accordance that they do otherwise. For example, searching for 

 1 Cr, 1ti 2, 1j 3 

brings up 1 Corinthians, 1 Timothy 2 and 1 John 3, resp. Searching for 2p or 2p-Jude brings up nothing. Try  

2pe or 2pe-jude 

to bring up the text of 2 Peter or of 2 Peter through Jude, resp. 

 

Simple Word Search 
 

To search for a word, choose Words in the argument entry box and choose the text you want to search. If you wish 

to narrow the search range, click the plus sign to the right of the argument entry box, click the menu under [All 

Text] (on the left), and define a new range. If you wish to search a field other than verse, e.g. sentence or paragraph, 

click the plus sign to the right of the argument entry box and then the plus sign that appears under the first plus sign. 

Select among clause, sentence, etc., under [Verse]. Enter your terms or construction in the argument entry box and 

hit <enter>. Scrolling, closing windows, copying, pasting, etc., work as in other Mac programs. 

Search text 

pop-up menu 

Display text 

pop-up menu 

Argument entry box 
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Example: We want to find all verses that use the word “king” in Matthew in the King James Version. 

 

Choose Words at the beginning of the argument entry box and choose KJV in the search text menu. 

 

To restrict the search to Matthew, click the plus sign to the right of the argument entry box and choose Define Range 

from the search range menu. Click New. Type in any name you wish for Name and tab to Definition. The same rules 

for entering biblical references in the argument entry box apply to the Definition of range box, so typing 

 mat 

will limit the search to Matthew. Click Update and close the box. Type the word “king” in the argument entry box. 

Press <enter>. 

 

On the left-hand side above the results list, it will say Verse X of Y where Y is the total number of verses found and 

X is indicates which verse is at the top of the text pane. The number of “hits,” i.e. the search items retrieved, is also 

above the results list but on the right-hand side. There are 23 flex hits in 22 verses in this example for “king” without 

quotes and 20 exact hits in 19 verses for “king” with quotes. Flex hits include all forms of an English word. Go to 

Accordance – Preferences – Search Tab – Flex Search to choose this option. Use quotes to specify an exact form. 

 

Example: To find in Genesis the word for “king” in Hebrew, set the search text pop-up menu to a tagged Hebrew 

Text such as BHS-W4. Choose Define Range from the search range menu and define Genesis as the new range. 

Press <Tab> to select the argument entry box and type mlk. Press <Enter>. 

 

By typing mlk, you entered the lexical form and retrieved the inflected forms as well in the search. If you want only 

a particular inflected form of a word, place quotes around it. 

 

Lexical and inflected forms for the search terms are options for tagged texts. Use quotes around a word to limit the 

results to the inflected form of the word you entered; otherwise enter the lexical form to retrieve all forms. 
 

Use * in the argument entry box to bring up all words in a text. 

 

You may also enter words in the argument entry box by going to Search on the main menu and choosing Enter 

Lexical Forms or Enter Inflected Forms. A box will appear which allows you to select the word you want. Click 

on a word or words to select them or begin typing the word in the Go To box or the Words To Enter box. Click OK 

when done, and the words will appear in the argument entry box. 

 

Exact form (English) “=sons” (without quotes) finds “sons” but not “son’s” or “Sons.” For tagged text it means 

exact lexical or inflected form—including capitalization, accents, and breathing marks in Greek; and vowel points, 

dagesh, and lemma numbers in Hebrew. Exact form is an option from Enter Lexical/Inflected Forms under the 

Search menu. Wildcards are allowed with exact searches. (See Additional Search Features below.) 

 

Grammatical Search 
 

In tagged text you may search by grammatical tags either alone or in conjunction with specific words. Type tags 

directly into the argument entry box (with the part of speech first) or chose them from the Tag option on the Search 

menu. 

 

Note: For the Hebrew verb tags under Other, see the online Help. In the Index, go to Hebrew and choose Verbs. 

Click Other under Hebrew and Aramaic Verbs. 

 

Example: We want to look at all neuter, plural, dative adjectives in the New Testament. 

 

Check to see that Words is chosen, that All Text is the search range, and that the search text is a tagged Greek text. 

Go to Enter Tag on the Search menu and choose Adjective. Under Gender choose Neuter, under Number choose 

Plural, and under Case choose Dative. Hit <enter> and [ADJECTIVE neuter plural dative] will appear in the 

argument entry box. Hit <enter> again to execute the search. 
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Example: We want to see all verses in which αγαπαω is inflected as an aorist participle. 

 

This example combines the lexical form of a word with tag constraints. Either type αγαπαω directly into the 

argument entry box or go to Search on the main menu and choose αγαπαω as the lexical form. Then go to Tag under 

Search and choose Verb. In the verb box pick Aorist under Tense and Participle under Mood. Hit <enter> to place 

αγαπαω@[VERB aorist participle] in the argument entry box. Hit <enter> again to execute the search. 

 

When you make a selection such as Aorist under Tense in the verb box, a small box appears to the left of the choice. 

Checking that box negates the choice so that any verbs which are aorist will be excluded. If you make a choice 

which you would like to reverse, select the blank space above the other choices. For example, if you chose Aorist 

and decided that tense does not matter, go to tense and choose the blank space. To make more than one selection in a 

given box, hold down the shift key and click with the mouse on any selections after the first. E.g., if you are 

interested in adjectives as nominatives or vocatives, click Nominative under Case and then hold down <shift> and 

click Vocative. 

 

Caution: In Hebrew, suffixes are treated as separate words for the purpose of searching; therefore, use a space to 

separate them from the word itself and use double quotes or tag details because suffixes do not have lexical forms. 

 

Homographs, such as lvm (rule) and lvm (proverb), are distinguished in the Lexical Forms list. Each lemma is 

followed by a number, and a different number means a different lemma. A “0” means the word is Aramaic while 

“1,” “2,” etc., indicate homographs. The numbers on the lemmas correspond to the numbers in HALOT. If you 

simply search for a root without a number, you will pick up all lemmas. 

 

Root searches find all nouns, verbs, and adjectives with the same root. Type a “+” before a root and search, e.g., 

“+βαινω” (without quotes). 

 

Additional Display Features 
 

To mark a verse, click in it and go to Mark Selection under the Selection menu. This will facilitate scrolling to 

verses of interest with the Mark button as well as mark them for other uses. 

 

If the Instant Details box is not showing when you work with a tagged text, go to Window on the main menu and 

select Instant Details. When you cursor over a word in the text, the Instant Details box shows its lexical form, 

parsing, root (in parentheses), and gloss. 

 

Click the bar chart icon to the right of the hits count after doing a search to display search results as a chart, table, 

or graph or to create a concordance. Select a text and right click for the option to execute a search for the selected 

text, view the context, parse each word, etc. 
 

Simultaneously scrolling text panes allow you to display multiple texts together, e.g., a Greek and English text. To 

view a particular text or set of search results in addition to the text already displayed, click the Add Parallel button to 

the right of the hits count, and choose a text from the list. There will now be two text panes side by side in the 

display text area. Click on a pane to make it active and scroll through the text as desired; text in the other pane will 

follow. Add more panes as needed. To close a pane, click the Close Pane icon at the upper left of the pane. 

 

Under Display, List All Book Names shows what books of the Bible or Apocrypha are included in the search text. 
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Additional Search Features  
 

Use quotes to search for a phrase, such as Son of God, in an English text. Adjacent words are treated as a phrase in 

Greek and Hebrew texts. 

 

Connecting commands in the Enter Command submenu of the Search menu may be used to find expressions in the 

same field. To use them, enter a word or phrase into the argument box and then select one of the commands before 

entering the next word. Two of the connections may need some explanation. The <XOR> is the exclusive or, which 

means verses are chosen which contain one expression or the other but not both. The <WITHIN> choice allows you 

to determine how close together you would like two expressions. For example, “milk <WITHIN 4 WORDS> 

honey” allows up to three words between the words milk and honey. 

 

The Link command links search arguments. For example, if you have a search tab with a complex argument and 

you would like to open another search tab with a different search range but the same search criteria, simply use the 

Link command to link the second search tab to the first. 

 

Use the Contents command to search another Search or Reference List tab. Choose Contents from the Command 

submenu under the Search menu and complete the search argument. For example, an argument such as “[Contents 

tab name] <AND> oxen” will find all verses in the Search tab named which use the word “oxen.” 

 

The Hits command differs from the Contents command in that the Contents command searches the contents of 

another search tab, and the Hits command searches the word list of a previous search. For example, search for all 

words (*) in the range John 13-17. Open another search tab and set the range to 1 John. [HITS tab name] in the 

argument entry box of the second tab will find all words in 1 John which appear in John 13-17.  

Use “*@-[HITS tab name]” to find words in 1 John which do not appear in John 13-17. This search is exact for 

lemmas but not for inflected forms. To pick up the same inflected forms, use [HITS=i tab name]. To pick up the 

same tags, but not necessarily the same lemmas, use [HITS=t tab name]. 

 

Read about Fuzzy and Infer in Help. They help locate approximate phrases and allusions, resp. 

 

To search a field other than verse, e.g. sentence or paragraph, click the plus sign to the right of the argument entry 

box and then the plus sign that appears next. The Search Field, which appears as a drop-down list headed by Verse, 

shows the possible fields in which a search may be done. For example, if you are performing the search 

 promise <and> Abraham 

setting the search field to Sentence retrieves all sentences that contain the words “promise” and “Abraham.” 

 

Parentheses may be used to group expressions to have them treated as a single expression. For example, “(X <OR> 

Y) <AND> Z” treats both “Z” and “X <OR> Y” as single expressions. Without parentheses, connecting commands 

are executed in the order in which they occur. 

 

There are two wild-card characters, “*” and “?”. The “*” represents 0 or more characters and may be used 

anywhere in a word. The “?” is similar but represents exactly one letter. You can find words with repeated letters by 

using questions marks. A question mark followed by parentheses containing an equal sign and a number “n” 

represents the same letter that the nth question mark represents. For example, i??(=1) would find “ill” and “inn.” For 

Hebrew, reverse the order, e.g., use (1=)??a. 

 

Construct Tabs 
 

A construct tab allows you to define criteria for your search graphically. To open a construct tab, select New 

Construct from the File menu and choose Simple, Greek, or Hebrew, depending on the type of text you are working 

with. In the search tab, click the Words button and select Link under Enter Command in the Search menu so that the 

construct acts as the argument of a search. The two windows are now linked together. The following is a brief 

overview; for more information see the Help menu or the online documentation at www.accordancebible.com. 
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To build a construct, drag the appropriate items into the columns to define each element of the construct. Drag the 

connecting items into the connection area to relate the construct elements. See that the construct tab is linked to a 

search tab with the desired range, field, etc., and click the search button to perform the search. 

 

 

 
 

Example:  + infinitive 

 

Have a search window open in search mode with the argument entry box blank. From the File Menu, select New 

construct and choose Greek. (This will automatically link the two windows.) 

 

With the mouse, drag LEX (for lexical) into the first element column. Type  in the lexical box. Next drag Art 

(article) into the second element column and click OK when the box comes up. Drag Verb into the third element 

column and choose Infinitive under Mood. To keep εν with the article, drag Within into the connection area above 

Lex and Article. Type a 1 when the box comes up and hit <enter>. To allow for the possibility of a single word to 

come between the article and the infinitive, drag Within into the connection area above Article and Verb and type a 

2. Your construct should look like the figure shown above. Click Search to perform the search. 

 

The element items consist of the parts of speech as well as LEX, INFLECT, ROOT, CHAR., HITS, COUNT, and 

PLACE. The parts of speech may be specified as they are when entered directly into the argument entry box. LEX, 

INFLECT, ROOT, HITS, and COUNT also work as they do in the argument entry box. Use CHAR. to find words 

containing a given letter. PLACE allows you to choose the position of an element in the search field, e.g. choosing a 

place of 3 in the search field, Clause, would mean that the element would be the third word in the clause. 

 

Connection 

area 

Element 

column 
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More than one element may be placed in a single column, but a hit word will match each item in the column. If you 

place multiple parts of speech in a column, however, the hit word will match only one of them. If you wish to delete 

an item, select it by clicking on its label, and press the delete key. 
 

When no connecting items are used, elements in a construct are order specific. Drag the connecting items, WITHIN, 

INTER, and AGREE, into the connection area over two columns to create different specifications. Linking arcs 

connect the two closest columns, but you may drag an arc by its box to connect it to a different column. 

 

WITHIN specifies maximum separation between two elements. INTER allows you to select words that may occur 

between the elements in a column. To define criteria for these words, drag element items into the INTER box as you 

would for an element column. AGREE specifies that certain grammatical details of two elements must agree; you 

may choose these details in the dialog box. 

 

Use the NOT palette item to negate an item in either the element columns or the connection area. 

 

Other Windows  
 

To add verses to a new or existing Reference List Tab, select or mark verses in a search tab and choose Add 

Selection To or Add Marked Verses To under the Selection menu. To remove verses from a list, select or mark the 

verses and choose Remove Selected Verses or Remove Marked Verses under Selection. Select by highlighting, and 

mark by right clicking. Open an existing reference file by choosing it from Open under File. Search the contents of a 

reference list by using the Contents command with the name of the reference window as part of the search argument 

in a search window. 

 

Tools windows and tabs give access to lexicons, cross-references, commentaries, and/or outlines, depending upon 

the modules included with the program. Open a Tools window from New under the File menu or at the top left of 

the workspace window. Use the Tool pop-up menu in the upper left of a tool window to choose a different tool. 

Hypertext by using the Entry arrows, the Reference box, or the hypertext links within the text. If you hypertext, 

Prior and Next buttons (triangular arrows) appear at the bottom of the window so that you may retrace your steps. 

 

Each tool is divided into articles or paragraphs. Search fields may include entry, contents, Scripture, etc. Choose the 

field to search in the pop-up menu in the search box. The tools are fully searchable, and most of the commands used 

for searching text apply. Commands apply within articles; bookmarks mark paragraphs; and hits are the total number 

of words that meet the search criteria. All text appears and hits are marked in All Text mode; otherwise only hits 

appear. Go to Show Text As under the gear icon on the right to change this. 

 

A Parallel window may be opened from New under File or on the workspace menu bar. Each parallel module 

contains a list of pericopes consisting of parallel passages. The field pop-up menu allows searching for a pericope 

title, a title number, or a Scripture reference. Only the simple operators AND, OR, NOT, and XOR are valid in the 

argument box, but you may link to another parallel window with the same field setting. The results of a search will 

be a list of pericope titles, which you then select to view. A double arrow appears to the right above the text window 

if there are more parallel passages than are shown. Click it to add a new text pane, and choose the passage you want 

displayed from the passage pop-up menu. 

 

You have the option to add user tools and user notes from the workspace menu bar. 
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Saving and Printing 
 

The save commands are listed under File in the main menu. Save Active Tab saves a single tab, Save and Save As 

will save the active workspace, and Save Session saves all open workspaces as Accordance files. This means that 

Accordance will be able to continue to work on them, but other programs such as Microsoft Word cannot open 

them. 

 

Save Text Selection will save text you select so that other programs can work with it. (Accordance, however, will 

not be able to open it.) If you are working with Greek or Hebrew text, be sure to choose the RTF option; otherwise, 

your documents may not appear in Greek or Hebrew characters when you open them on another computer. RTF 

saves font and style information. 

 

Save as Picture is an option for windows with graphical contents. This option saves the contents of a window as a 

PICT, JPEG, or PNG file which can be opened in another program. 

 

To choose the font for Greek and Hebrew export, go to Greek & Hebrew in Preferences under the Accordance 

menu. Saving Greek text in the Helena font and Hebrew in Yehudit keeps the characters as they are in Accordance. 

 

Print Settings are under File. You can check Print all panes here or uncheck it to print only the selected pane. 

Choosing None (All Interleaved) under Column interleaves all panes so that the text of the other panes follows the 

text of the first pane. Tool and User Notes panes print only the entries that match the Bible verse being printed. You 

can also choose to have page numbers included. 

 

For further help, try the Help menu or go to www.accordancebible.com. Feel free to ask reference staff any 

questions you may have. 


